
1 

 

What does OECD eXplorer enable you to do? 
An introduction to its main features 

1. Overview ........................................................................................................................................ 2 

2. Load data in eXplorer ..................................................................................................................... 4 

For a single year… ......................................................................................................................... 4 

…Or a time span of years ............................................................................................................... 4 

…And add your own data .............................................................................................................. 4 

3. How does your region stack up? .................................................................................................... 5 

Choropleth Map View .................................................................................................................... 5 

Select countries to be explored ....................................................................................................... 6 

Colour Legend and Colour Scale ................................................................................................... 6 

Selection Details View ................................................................................................................... 9 

4. Explore statistical relations with the Scatter Plot ......................................................................... 10 

Zoom in Scatter Plot ..................................................................................................................... 10 

5. Parallel Coordinates Plot (PCP) View.......................................................................................... 11 

Specify indicators to be used in the PCP ...................................................................................... 13 

Visual Inquiries based on dynamic filter operations .................................................................... 14 

Visual Inquiries based on statistical methods ............................................................................... 15 

6. Time Animation ........................................................................................................................... 17 

Time animation step-by-step ........................................................................................................ 19 

Time animation in Scatter Plot ..................................................................................................... 21 

7. Data Grid View ............................................................................................................................ 22 

8. Print or save the images in documents ......................................................................................... 23 

9. Story telling .................................................................................................................................. 23 

Storytelling step-by-step .............................................................................................................. 25 

 



2 

 

1. Overview 

 

Figure 1: OECD eXplorer’s getting-started layout is based on three multiple-linked and coordinated views 

(Choropleth Map, Scatter Plot and optional Parallel Coordinates Plot (PCP)).The indicator “Labour 

Productivity” for all OECD TL2 regions represents the colour scale. The Scatter Plot shows relation between 

“unemployment Rate” vs. “GDP per Capita” (vertical axis). OECD eXplorer opens with a preloaded Story with 

selected indicators and displaying all four OECD continents in the Choropleth Map. The Story’s metatext is 

shown in the Story Panel (right). A continent is selected by a click on the cross in each map view. Splitters can 

adjust the size of any of the views. Indicators to be analysed are selected in the combo boxes attached to the 

Colour Legend and Scatter Plot axes. The optional view PCP is open in the View Menu or use the lower splitter. 

OECD eXplorer (eXplorer) is a web-tool that enables the visualization of socio-economic 

information at detailed territorial level providing clear insight on regional differences and performance 

within a country and comparison of different areas across countries. eXplorer enables users to explore 

spatial, temporal and multivariate data from multiple perspectives simultaneously, to discover 

interesting relationships, to share their incremental discoveries with colleagues and finally to 

communicate selected relevant knowledge to other users.  

eXplorer is composed of GeoAnalytics Visualization (GAV) components facilitating a broad 

collection of dynamic visualization methods integrated with the Adobe
©
 Flash

©
 and Flex

©
 

development platform. In this respect, eXplorer represents a leading edge tool having being adapted 

to the Internet and used as a web-enabled toolkit. 

 The statistical dataset contained in eXplorer is the OECD Regional database which contains 

yearly time-series for around 50 indicators on demography, economy and labour market opportunities, 

environment, social issues and innovation related activities for more than 1,700 regions of the OECD 

countries. Regions within each OECD country are classified on the basis of two territorial levels: the 

higher level (TL2) consists of 335 large regions (figure 1) while the lower level (TL3) is composed of 

1,679 small regions.  
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In order to detect trends and gain understanding and knowledge within the data it is convenient to 

view it through a number of different visual representation methods, each of which is best suited to 

highlight different patterns and features. eXplorer’s user interface is divided into three dynamic linked 

views (figures 1 and 2): Choropleth Map, Scatter Plot and Parallel Coordinates Plot (PCP). These 

views are separated by interactive splitters (figure 1), allowing the user to scale the sizes of individual 

views. The Scatter Plot share views with the Data Grid, while the PCP shares with a Time Graph (only 

for time animation).  

Coordination between views uses a novel data linking method where the visualization components 

use the same data model and colouring scheme. A selection made in one of the visualization 

components propagates to all the others. An example, exploring only Italian regional data, is shown in 

figure 2, facilitating a linked coordination between the three main eXplorer views: choropleth map, 

scatter plot and parallel coordinates. The same colour map representing indicator “age group 65+” is 

applied to all views and the regions Liguria and Lazio (Italy) are highlighted in all views. 

 

Figure 2: Example of an eXplorer linked view scenario (choropleth map, scatter plot and parallel coordinates) 

for the Italian regions facilitating for the analyst to discover patterns of events and relationships within a 

geospatial context. This layout uses points (Scatter Plot), lines (PCP), and polygons (map) to explore regional 

data.  The chosen colour map indicator is “age group 65+”. Two regions Lazio and Liguria are highlighted in 

all three views for comparison. Each string (line segment) in the PCP represents an Italian region, coloured 

according to chosen indicator. Each of the five vertical axes represents an indicator.   
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2. Load data in eXplorer 

 

 

Figure 3a: Use the menu Indicator to 

Load Data. First select territorial level 

of regions (small or large) in the right 

menu then select data for a “single” 

year, “latest” available year or “time 

span”. Data are organised into 

categories (Demographics, Economic, 

Social and Innovation). Select 

indicators by clicking in a box. 

 

 

 

 

For a single year…  

All indicators of the OECD regional database and their associate data are preloaded in eXplorer and 

can therefore be accessed immediately. To access all the data, use the top menu Indicators>Load 

Data window (figure 3a). First select “territorial level” mode (TL2, TL3 or TL3+NOG), then select 

“latest data”, “single year” or a “time span” for animation mode. Data that is available depends on 

your choice and will be listed in the left column organized according to topics Demographics, 

Economic, etc. Load as many indicators as you want (previous choices are saved). If you switch from 

one territorial level to another previous choices are lost and you must select data from start again. 

…Or a time span of years 

In time span (animation) mode, you can select “minimize time span” where selected indicators 

must have data for all years or alternative “maximize time span” where selected indicators can have 

“no data” for certain years. The icon next to the indicator’s name shows the available years. 

Figure 3b:1) Indicator data are preloaded; 2) Data can be 

input from a client local data file (the format is described in the 

Help menu “How to load your own data”;3) A Story can 

include external data (not available in the preloaded data 

source). Stories built from temporal data are marked with a 

“movie” icon. 

 

 

 

 

 

…And add your own data 
eXplorer also supports import of your own data (figure 3b) using an Excel-like format “Unicode”. 

Additional data can be loaded using the top menu Indicators> load your own data window. The 
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additional data must, of course, be related to the OECD regions and maps. A detailed description of 

the data format can be downloaded from the Help menu. 

3. How does your region stack up? 

Choropleth Map View 

 

Figure 4: The standard eXplorer layout with a Choropleth Map View (including the colour legend) and 

associate Scatter Plot. The mouse is placed over London and a tooltips is displayed. 

The Choropleth Map view (figure 4) shows the geographical borders of all regions in the data set, 

divided into the four continents that have OECD countries. Each region is coloured according to the 

current assigned colour map indicator. To focus on one of the four continents (figure 1), click the 

small button in the bottom right corner of one of the views. This will switch to a single map view for 

selected continent. By selecting, for example Europe, all regions and their associate data from the rest 

of the world will be hidden in all views. The other views will thus only show data for, in this case, 

Europe. 

Basic pan and zoom functions are available through mouse left-click and drag (pan) and mouse wheel 

scroll (zoom) respectively. Alternative you can use the pan-zoom GUI panel in the upper left corner. 

The actual value for a region is displayed by moving (hovering) the mouse above it (tooltips). By 

clicking with left mouse button on a region, it becomes selected (highlighted) in the map but also in all 

other views (see figure 4 where London is emphasized in the Map and Scatter Plot views) You can 

select (highlight) several regions by clicking with the mouse on the region and pressing the CTR 

button on the key board at the same time. 
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Select countries to be explored 

 

Figure 5: Selected countries France, Belgium, Luxembourg, Germany and Nederland are explored in the 

map and scatter plot. Two regions with high “population Growth Rate” are highlighted. The Scatter Plot shows 

“age group 0-14” vs. “age group 65+”.  Noord-Brabant has also a high rate of younger people.  

Select individual countries to explore. Menu Options >Choose Countries. Mark countries to be 

explored:  Belgium, France, Germany, etc. Only the selected countries will be coloured in the map and 

displayed in the Scatter Plot and PCP. 

Colour Legend and Colour Scale 

 

Figure 6: The Colour Legend plays an important role in eXplorer and provides many features and options 

that are important and can well influence the visual result. 

Colour coding is a fundamental technique for mapping data to visual representations with three 

fundamental goals: 

1) To serve the purpose of the map based on its intended audience, use and data; 

2) To communicate the map’s information in the most efficient manner, with simplicity and 

clarity; 

3) Intuitive interactive tools to enable users to adapt colour scales according to their needs; 

Colour coding is often provided in a limited way only or it is not used effectively. Furthermore, 

adapting colour scales automatically by applying a simple minimum-maximum-scaling often results in 
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visual representations of different views on the data which cannot be compared with each other. This 

chapter describes how appropriate automatic or user defined colour coding schemes can enhance the 

visual exploration of spatial or spatial-temporal data. From a collection of schemes (figure 6E) the user 

chooses the most appropriate one (sequential or diverging) with respect to the users’ visualization 

goal. 
 

The eXplorer scalar colour mapping area (colour legend) is used to assign colour to each scalar 

value in the dataset. This will allow you to, for example, assign a blue colour to regions with a low 

“population growth rate” while assigning red to regions with higher growth rate. An example of this 

interface is shown in figure 5.  

The selection of the indicator that controls the colour map can be done in three ways: 1) through 

the combo box next to the colour legend (figure 6A “Select Indicator”); 2) the top icon to the left of 

the colour legend (6A “Colour Scale Selection”); 3) clicking on the indicator name in the headers of 

Parallel Coordinates axis (see more below). 

By assigning an indicator for the colour scale associated with the colour legend, all views will be 

coloured accordingly. The region with the highest data value will get the colour specified at the top of 

the colour range, and the lowest will get the bottom colour. All regions in between receive a scaled 

colour based on their respective values. eXplorer’s standard approach of the visualization scales the 

colour map according to value density based on percentile calculations, which means that value ranges 

with a high amount of regions receive a larger range of colours to help distinguish them.  

The default colour scale representing the values associated with an indicator is considered within 

the regional data set. Perceptual distances within a colour scales reflect distances in the data. 

Moreover, a colour scale could reveal whether a selected indicator contains zero values by creating 

intervals. The first (top) icon (6A) initiates the “Colour Indicator and Scale” (6E), where the user can 

choose a diverging colour scale (blue-to-red or red-to-blue etc) or sequential. 

The third icon (6A) from the top (percentile distribution) splits the data into four intervals or bins 

based the 10
th
, 50

th
 and the 90

th
 percentiles (figure 6B and result in 7A). This provides a better 

automatic distribution of colours related to the data based on an accurate statistical method and the 

visualization is improved in a way that differences between values can be more easily detected. Colour 

scale values can also be adjusted dynamically by moving the handlers. The percentile and 

corresponding data values are shown to guide the user when moving any of the handlers attached to 

the colour scale legend (figure 8B).  

The user can also switch to 25
th
, 50

th
 and 75

th
 percentiles by moving the mouse over the percentile 

icon (6A) to the right and an arrow will appear giving the user a choice. The result is shown in 7B. 

The second icon (6A) use a linear interpolation based on the minimum and maximum values, this is 

effective if the structure of the data is accurately represented. However, linear interpolation leads to 

problems if the values of an indicator are not uniformly distributed (e.g. if outliers are present). In this 

case a wide range of the colour scale represents a small number of values and the majority of values 

are placed in a narrow range of the colour scale.  See result in 7C. 

The user can also click on a scale value (6D) to assign a user preferred value - a box is shown for 

editing the value. This method is appropriate to assign, for example, a "zero value" in a diverging 

colour scale (blue-to-red etc).  

The last icon “user scale” (6C and 7D) gives the user the possibility to assign own discrete user 

scale values that don't reflect distances in the colour scale, i.e. the user has control of both the colour 

distribution and scale values for maximum customization. The user clicks (6D) on each scale number 

and assign a new value.  This is especially useful for Time Animation when linear interpolation is used 

to calculate the class values. 

A histogram showing the distribution of regions along a linear axis is displayed in the Parallel 

Coordinates view (Figures 15-21) and can further guide the user to select a suitable colour scale based 

on the distribution of data values. 
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Figure 7: A: percentile 10th, 50th and 90th; B: percentile 25th, 50th and 75th; C: linear colour scale; D: user 

defined colour scale; 

The dynamic handlers (sliders) in the colour legend can be moved to assign new class values.     

Figure 8A shows the resulting map with indicator “population growth rate” from the default 

assignment of class values based on the percentile 10
th
, 50

th
 and 90

th
 calculation. In 8B, the user has 

first assigned 0.0 to the centre point (where blue change to yellow/red) in the diverging colour scale. 

Double click on the class value to be edited and a box pops up, assign a new value then OK. Next, the 

dynamic handlers are moved to new suitable class values -2, -1, +1 and +2. In figure 8B, regions with 

high and low “population growth rate” can more easily be distinguished.  
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Figure 8A and 8B: Left map shows a diverging (blue-to-red) colour scale based on the default percentile 

calculation 10th, 50th and 90th. In the right map, the user has assigned the class value 0.0 to the break point 

between blue and red. This means that regions with negative growth value will be blue and positive yellow-to-

red. 

Selection Details View 

Once one or more regions have been selected in the map or in the scatter plot, you can view the 

values for all the indicators referring to those regions. The “Selection details” view is activated with 

View>Selection details in the Menu. 

 

 

Figure 9: The selection details Panel is used to display data value for selected (highlighted) regions. 
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4. Explore statistical relations with the 

Scatter Plot 

The Scatter Plot is a graph that displays how two indicators in the data set relate to each other. A 

region is represented by a dot at the intersection values for the two indicators chosen on the X-axis and 

Y-axis. The plot also shows two extra dimensions through the use of colour, which is shared between 

all views, and through the size of each dot, so the number of indicators simultaneously analysed is 

increased to four. 

To change which indicators to be displayed, use the three combo boxes (figure 10), one for each 

axis and one at the top for dot size. The maximum dot size can also be adjusted through a bar on the 

right hand side. Hovering (tooltips) above a dot (region) will display detailed information, and clicking 

on the dot will select (highlight) the region in all views along with the Scatter Plot. 

You can select (highlight) several dots (regions) by clicking with the mouse on the dot and pressing 

the CTR button on the key board at the same time.  Alternative, click on one or several regions in the 

map and the corresponding dots will be highlighted in the Scatter Plot. 

 

 

Figure 10: Scatter Plot with 3 dimensions horizontal-axis, vertical-axis and size of scatter point. The colour 

of the dot (4th dimension) is controlled by the corresponding PCP indicators. One slider controls dot area 

scaling  

Zoom in Scatter Plot 

A zoom function in Scatter Plot is initiated by holding down left mouse button and at the same time 

draw a rectangle (figure 11). Regions inside this rectangle will be zoomed in and axis scaling and 
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annotations are changed accordingly (right image). Zoom can also be initiated by using the middle 

mouse scroll. This alternative zoom function also depends on the position of the mouse.  Zoom can be 

cancelled by a click on the 1:1 icon in lower left corner of the Scatter Plot. The zoom function can also 

be used in animation mode to highlight regions close to each other.  

A 
Figure 11: Zoom function in Scatter Plot. In the left image a zoom window is selected by a mouse movement with 

must button pressed. The right image shows the resulting zoom window. 

Zoom can also be initiated after filter operations have been used in Parallel Coordinates Panel (see 

more about PCP below). By clicking on the Icon in the lower left corner a zoom is performed based on 

the remaining regions in the scatter plot after a PCP filter operation.  

5. Parallel Coordinates Plot (PCP) View 

eXplorer introduces a novel enhanced Parallel Coordinates Plot (PCP) method for Adobe Flash. 

PCP is a proven geovisualization technique for identifying trends and cluster in many scientific 

environments but has not been commonly used in statistical work. PCP enables visual representation 

of spatial multivariate indicator (variable) data and hence could become an important mechanism in a 

Geovisual Analytics application, such as eXplorer. Each region is represented by a string (line) 

passing through the parallel axes intersecting each axis at a point depending on the indicator value of 

region.  Each axis represents a single indicator. A highlighted string forms a visual representation of 

the characteristics of one region (Paris in figure 12).  
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Figure 12: A PCP representation of a data set with 4 indicators for France only, where “population age 

group 65+%” represents the coloured indicator. Each axis represents a single indicator and regions are 

represented by coloured strings (“population 65+ %) passing through the axes. PCP facilitates exploration and 

analysis of the relationships between several indicators and regions. Negative relationship, for example, is 

shown between indicator "Population 15-64" and "Population 65+". Similar profiles of selected regions can be 

seen by highlighting". Paris, for example, is highlighted in a black thick line. The green thick line represents the 

mean value for each attribute and allows a comparison between actual and mean value. Each column in the 

Data Grid corresponds to an axis (indicator) in the PCP. A string corresponds to a row (region) in Excel. 

 

The PCP has been extended with special features that are important to statistical exploration, such 

as, histograms and filter operations based on percentile statistics and provides the following features: 

 Revealing correlation between indicators; 

 Estimation of degree of similarity between regions; 

 Finding clusters and outliers; 

 Analyze the characteristics of many regions;  

 Picking and highlighting of interesting data items for profile and comparison; 

 Comparison of individual characteristics of a region to the characteristics of all regions; 

 Comparison of indicators associated with a selected region; 

 Comparison of variations of values of different indicators; 

 Dynamic range sliders and statistical methods for defining events such as exceeding of a given threshold 

and identification of outliers; 

 Dynamic visual inquiries, filter operations using familiar statistical methods; 

 Facilitates dynamic animation in linked and coordinated views; 

 

Figure 13a: The profiles for two regions are compared. The lines are displayed with two different line types to 

be able to distinguish between the region profiles. The lines are coloured by the first indicator axis “Elderly 

Dependency Rate %”. Inquiries and filtering (removing) regions can be performed using range sliders 

positioned at the top and bottom of the axes. 

Figure 13b below: Indicator “age group 65+” represented by one PCP axis with minimum value at the bottom 

and maximum at the top. The axis is divided into15 equally sized bars. The length of the bars depends on the 

number of lines (regions) crossing the axis at within the bar. Examples of 1, 3 and 

4 lines crossing are displayed.  

Histograms (figure 13a and b) attached to each PCP axis are used to 

visualize the distribution of the indicator data values, splitting the axes into 

a user defined number of equally high rectangular areas (bins). A coloured 

region line intersects the PCP axis at a point depending on the indicator 

value and is then sorted into corresponding bin.  The length of a rectangle 

indicates the frequency of regions intersecting that bin, the more regions 

within an area the wider the rectangle. Histograms can be turned on/off and 
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the number of bars can be specified. Histograms are dynamically moved during a time animation and 

can expose interesting trends over time. 

 

 

Figure 14: Three linked views Scatter Plot, a section of the Parallel Coordinates and Selection Information 

display the same information from a different perspective. Two regions Brussels and Oslo are highlighted. 

Specify indicators to be used in the PCP 

 

Figure 15: Default assignment of indicators to the PCP. The GUI panel to the left allows users to specify, for 

example, indicators to be explored and filter method. Display Histograms along the axes and number of bars. 

More detail settings, for example, opacity control for lines are available in panel “Advanced settings”. 

 

PCP default selects the first 5 indicators from the data set (see left 

panel). However, the choice, number and order between indicators are 

important.  

“Set Indicators” button (figure 15) open a panel (see left) with all 

current active indicators. The panel shows which indicators are used and 

their order in the PCP. The user can now select indicators to be used in 

the PCP and select their internal order. 

1: Four indicators (Elderly, GDP per capita, Unemployment and R&D 

Expenditure-Education) are selected for the PCP analyse; 

2: You can change the order of the indicators in the PCP by holding 

down left mouse button and drag the indicator to another position;  This 

allows you to see the correlation between two adjacent indicators (4); 
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3: The result after moving the “Unemployment Rate” to a new position in the PCP; 

4: Correlation between “Elderly Dependency Rate” and “Unemployment Rate”. 

 

 

Figure 16: Changing the order of the selected indicators is achieved by holding down the left mouse button and 

drag the selected indicators to its new position. 

 

Figure 17: We compare four selected regions Berlin, Paris, Brussels and London for nine indicators. By 

assigning different line styles to each region, we can distinguish each region and make comparisons.  We also 

compare them against the Mean value (value) for all regions. The name tags were added to the last axis in the 

PCP later by hand for publication. 

 

Visual Inquiries based on dynamic filter operations 

Another advantage with the PCP exploration technique is the capability to dynamically make visual 

inquiries and filter data. Each indicator axis has a pair of range sliders which define the bottom and top 

range for the query area. The range of an indicator can be specified by “dragging” the handles on the 

top and bottom of the corresponding range slider (figure 13a and 18). Regions with values for a selected 

indicator, that fall outside of the specified range, are filtered out. A combination of range slider movements 

(figure 18) can be used to dynamically formulate a more complex visual inquiry. These visual conditions 

and constraints will immediately reflect the visual contents in all linked views. An example of a query 

using the sliders is shown in figure 18. After a dynamic query operation, applied to the indicator 

"Labour Productivity”, regional values below the mean (green line) were removed. A tooltips shows 

the exact value for the slider position along the indicator axis. A second condition is then given for 

indicator “Unemployment rate”, where regions with higher rate (above mean value) are removed. 
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Figure 18: Filter operation is performed with range sliders positioned at the top and bottom of each 

indicator axis. Two filter conditions are performed here: 1) Keep regions with high “Labour Productivity” 

(above mean value) AND 2) Keep regions with low “Unemployment Rate” (below mean value). The map to the 

left shows the result after removing the regions that do not fulfil these two conditions. Only regions with yellow-

red colours remain in the map and all other views. 

Visual Inquiries based on statistical methods 

Using range sliders described above offers control of the data value of the filtering threshold. 

However, it does not return any information on the number of data items removed, and is limited to 

removal of data outside of the range slider. To support visual inquiries using statistical measures a 

novel filtering method based on percentile values has been implemented in the PCP. This statistical 

concept can be used to better facilitate the overview and understanding of data distribution. By 

representing the position of specific percentiles along the axes the user can easily get an understanding 

of the distribution of regions for current indicators. In figure 19, the percentile levels and 

corresponding data value are marked out using tooltips to the right of the percentile slider. 

 

 

Figure 19: The filter operation for “Labour Productivity” is here performed with a statistical correct 

operation based on percentiles. Select Percentile in the PCP GUI panel (figure 15). Two percentile sliders 

marking the 90th and 10th percentiles are displayed for all indicators. By clicking on the symbol x between these 

two markers, all regions between the 10
th

 and 90
th

 percentiles are removed. Remaining regions representing the 

“outliers” are shown in the left map.     
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Figure 20: Regions (outliers) with a low and high population distribution for “Elderly Dependency Rate %” 

are discovered using the statistical method percentiles. Regions above the 10th percentile and below the 90th 

percentile are removed by a simple click on the circle with an inside x symbol. The 10th percentile level and 

corresponding data value is shown as a tooltips operation along the percentile slider. The histogram displaying 

the distribution of regions along a linear axis can further guide the user to select filter conditions based on the 

distribution of data values. 

Given a range limited by an upper and a lower percentile value, filter operations can be performed 

either inside or outside of that area by clicking on the removal circle with an inside x symbol. This is 

shown in figure 20 above where all regions between the 10
th
 and 90

th
 percentiles are removed (filtered 

out) by one click. For example, the following conjunctive query: "Find the extreme regions for 

indicator "Elderly Dependency Rate" below the 10
th
 and above the 90

th
 percentiles.  

We have adopted a similar percentile calculation in the dynamic colour legend component as 

described previously. 

 

Figure 21: The percentile filtering method is used to highlight the regions with highest and lowest percentage of 

labour force. The attached histogram shows the frequency distribution for the indicator. 
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Figure 22: Three methods to compare the profiles of two regions. 

6. Time Animation 

Figure 23: Example of an eXplorer time animation facilitating for the analyst to discover patterns of events, 

relationships, and interactions over time within a geospatial context. Selected regions of interest are represented 

as “time profiles” in the Time Graph above for a given indicator. All five views are dynamically time-linked and 

updated with immediate smooth results. In the figure above, a region in Italy with high elderly population (65+) 

Liguria is highlighted in all views for comparison. The Scatter Plot and Time Graph show that the elderly 

population during 1990-2005 continue to grow. All views are connected to the same data cube model.  

GAV Flash employs a novel data model (figure 24) optimized for handling spatial-temporal and 

multivariate indicator data sets in a GeoAnalytics context. This conceptual data model can be seen as a 

data cube with three dimensions: space, time and attributes. The spatial dimension is represented by 

the OECD territorial levels (TL2 or TL3), while the attributes dimension is represented by the 
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indicators, and the time dimension is represented by the value of the indicators in each period of time. 

The general method for finding a value in the cube is by its position [space; time; attribute;]. 

 

Figure 24: Data cube model applied in OECD eXplorer. 

Space-time-indicator awareness means that the data cube can be analysed and visualized across all 

three dimensions simultaneously. eXplorer performs this task by integrating and time-linking three 

visual representation views: choropleth map, PCP and scatter plot (bubble). The bubble plot is 

demonstrated to be an effective Flash-based time animation method, but integrated and linked with a 

choropleth map and a multivariate indicator frequency histogram embedded in a PCP, makes it even 

more useful. The GAV open architecture, handling of large datasets and integrated Story mechanism 

are other important extensions to this emerging animation technique. 

 

 



19 

 

 

Figure 25: Example of 3 time steps in an animation covering the years 1995-2005. Indicators are “age group 

65+” and “0-14”. Four regions (Slaskie, Poland; Liguria, Italy; Hovedstadsregionen, Denmark; and Galicia, 

Spain) of special interest to analyse are highlighted in the map and Scatter Plot. The 4th colour scale (figure 6E) 

is chosen based on 6 distinct separable colours from dark blue to dark red with corresponding user defined class 

values (figure 6C) are specified in the colour legend. A trace displayed behind each highlighted region indicates 

its movement during the time range.  

 

Figure 26: Time animation displayed in the PCP showing the four comparable highlighted (profiles) regions 

from figure 25 for six indicators. During time animation you see these lines moving softly between years. The 

histograms also move showing how the distributions of data values (regions) for each indicator change over 

time. We see, for example, how the “age group 0-14” changes between 1999 and 2005. The growing 

“unemployment rate” is also noticeably displayed.  

Time animation step-by-step 

1) Indicator > Load Data>Select “Time span” (available indicators with time step data is 

displayed); 

2) Select “Minimize time span” or “maximize time span” and years to focus on; 

3) Select the indicators to be analysed; the (i)  icon has Meta information about the indicator and the 

time icon  shows the available time periods; Click Load; 
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4) The Map and Scatter Plot views are displayed together with a Time slider panel;  

5) Select Indicator “65+ “ for colour mapping; Select Indicator “0-14” and “65+” for Scatter Plot 

axes, select “Total population” for dot size. 

6) A default colour scale is for a time animation calculated linearly from the Min (2.22) and Max 

(26.51) values for Indicator “65+”. The default calculated class values are not suitable for this 

time animation. First, another colour map is selected (4
th
 from the top with discrete colour steps). 

User defined class values (10, 14, 17, 20 and 24) are set by moving the dynamic handler along the 

colour legend or by a double click on the class value resulting in a popup panel where a class 

value can be written. See figure 28. 

7) It’s difficult to analyse time animation when all dots are moving. Select interesting regions to be 

highlighted during the animation. Four regions are highlighted in this time animation (figure 25). 

 

8) Now, start moving the time slider (c) by hand or (a) automatically. The current time step is 

updated (d) and in the Scatter Plot background. (b) sets the automatic animation speed. 

9) You can now easily follow the movements of the selected regions and also see the name attached 

to these regions. A trace is displayed following the movement of selected regions. 

10) When the last time step 2005 is on, you can select any region and see their corresponding time 

trace for 1995-2005 without moving the time slider. 

 

 

Figure 27: For the last time step – you can highlight any region and see a trace that represents the time 

movement. Here, two regions are highlighted for time step 2005. 
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Figure 28: For time animation, a default (linear) colour scale is calculated from the Indicator’s Min and Max 

value. An alternative colour map is here selected. User defined class values are specified by moving the dynamic 

handlers or by a double click on the class value to be changed and write the new value in the popup panel. 

Time animation in Scatter Plot 

If the selected indicators represents time varying data then the selected dots will move over the 

Scatter Plot and highlighted regions will also leave a trail (figure 29) when moving the time slider. 

You can easily see how highlighted regions perform over time. 

 

Figure 29: Time animation “age group 0-14” vs. “age group 65+” during 1990-2005 in Scatter Plot. Four 

regions are highlighted. Their traces show movements during 1990-2005. 
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7. Data Grid View 

 

Figure 30a: Data Grid view is kind of an Excel Sheet where all regional data values are displayed in a 

textual form.  Two Italian regions are in focus and highlighted in both the Map and Data Grid views. 

The Data Grid view corresponds to an Excel Sheet where all regional data values are displayed. 

Each row represents a region and the columns are the selected indicators. Only active regions are 

displayed. Regions removed by a filtering operation (e.g. PCP) are not shown in the Data Grid. Values 

of indicators can be sorted by clicking on the header. 

 

Figure 30b: Data Grid where column “GDP per capita” is sorted (click on the header) after ascending 

order. Oslo is highlighted representing the third highest GDP per capita region in EU. 

 

Figure 30c: Data Grid after a PCP filter operation (see embedded part of the PCP in map). Regions with 

high “Unemployment” are in focus after a linear filter operation has removed all regions with an unemployment 

rate below 15.50%. German region Second highest unemployment region Mecklenburg-Vorpommern is 

highlighted. 
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8. Print or save the images in documents  

The simplest way to save the views provided by the eXplorer is by taking a screenshot. A 

screenshot is an image taken by the computer including all the visible items in the screen. To take a 

screenshot: 

1) Maximize the window where the eXplorer is running; 

2) Turn on the “Full screen” option of the web browser to hide the navigation bar. In both 

Windows Explorer and Mozilla Firefox, this can be done by selecting View > Full screen; 

3) Once the window is fully opened, press the “Print Screen / SysRq” key to take the screenshot; 

4) The image can now be pasted into a Word or PowerPoint document by clicking the right 

mouse button and selecting the “Paste” option (or by pressing “Ctrl + V”). 

A screenshot includes all the active views in the eXplorer. To capture a particular view, the rest of 

the views must be inactive. For instance, to capture the map view (below), the scatter plot and the 

story telling views have been switched off using the View menu in the top bar of the explorer. 

 

 

9. Story telling 

Complex and collaborative geovisual analytics sense-making tasks require the external 

representation and visual organization of information. These methods could help users to compare, 

organize, comprehend and reflect on what they know, to quickly access specific information when 

needed, to remember relevant thoughts and ideas, as well as to exchange knowledge and develop a 

shared understanding with other people. Computer generated information visualizations usually 

explicitly state relationships among information items thus allowing for quick and non-ambiguous 

explorations of an information space. Human generated information arrangements are often vague in 

regards to relationships thus inviting more creative interpretations of an information space. The GAV 

Flash Framework integrates tools for both collaborative interactive visualization and sense-making. A 
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story indicates a successful suggestion and subsequently fosters additional suggestions based on 

similar considerations. This learning mechanism allows our storytelling system to improve the 

accuracy of its suggestions as well as to dynamically adapt to particular users, tasks and 

circumstances. Colleagues can review a story arrangement and respond with suggestions and 

comments and subsequently fosters additional suggestions based on similar considerations. 

 

Figure 31: Example of a geovisual analytics discovery that was captured on March 19th and saved as a story 

called “High level education in EU”. This story is once more opened and explained. The colour indicator 

represents "Percentage of labour force with completed tertiary education". Three regions, Pais Vasco (Spain), 

Brussels (Belgium) and Oslo (Norway), have the highest education level among the labour force and are 

highlighted in all views. Their profiles (different line types) can be compared in the Parallel Coordinates view. 

Brussels has the highest unemployment rate, while Oslo surprisingly has a low basic education rate. Pais Vasco 

has lower GDP per capita than the others. The scatter plot shows a correlation between "R&D expenditure" and 

"Labour force with tertiary education". The Story (right panel) shows the metatext for current story and a list of 

associated stories. 

eXplorer facilitates the architecture to support means of capture, add descriptive text, save, 

packaging and sharing the discovery and results of a geovisual analytics process in a series of 

snapshots to create a “Story” (figure 31). When the button “Capture” in the Story Editor is pressed, the 

state of each view (figure 32) in eXplorer is saved together with user-defined metatext. Before closing 

the application, the user exports the story into a XML formatted file. Team members can through 

descriptive text combined with interactive visualization follow the analyst’s way of logical reasoning 

by loading selected stories. At any time a team member can access stories and apply them in 

eXplorer. A comprehensive story in the context of a remote collaborative sense-making activity can 

thus be created by the analyst through a set of linked snapshots (chapters). Users will discuss relevant 

issues through storytelling based on solid evidence, thus raising awareness and increasing the common 

knowledge on a certain phenomenon. 

Meta text 
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Storytelling step-by-step 

1)  During an eXplorer session, the analyst first selects regions to be analysed and associate 

indicators. Search for trends, outliers, discovers important observations, highlights regions to 

be compared etc. - a discovery is made; 

2) Open the Story Panel (right view figure 31) if the panel is not already open. 

3)  Create a Story, a Story Editor panel comes up; 

4) Press Capture! The entire eXplorer session with data, views, highlights, zoom etc are saved; 

5) Fill in the required information and associate meta or reasoning text; 

6) The user can now start a new Chapter in the Story and create a new scenario and repeat the 

process 1) 4) and 5) above by pressing the button “New” in the Chapter panel; 

7) When the Story is completed then press Close; 

8) Use the button Save as, give the Story a name "my story nr 2".xml. REMEMBER the prefix 

.xml!  

9) The Story is now saved locally on your computer and can be reused Open or sent to a 

colleague for review in eXplorer. 

 


